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WARNING
	 Make sure you download any pictures from your camera BEFORE removing 

or changing batteries, unless you have been using an SD card rather than the 
internal memory for photo storage. We recommend you download all current 
photo files for safekeeping before storing the ImageView away if you are not 
using an SD card in the camera, in case the batteries become depleted during 
extended storage. 

WARNING
Do NOT look directly at the sun through your binoculars.

Doing so may cause permanent eye damage.

NOTE: To reset the camera if you experience problems or if the display becomes 
unresponsive, remove the batteries for at least one minute, then re-install them. 
This may result in the loss of all photos/videos stored in the internal memory.
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Congratulations on your purchase of the Bushnell ImageView® 

binocular! The Bushnell ImageView binocular takes the technology 

of digital photography and combines it with a high-quality compact 

binocular.  This allows you to observe sporting events, wildlife, scenic 

vistas or anything you would normally use a binocular for, and then 

save the image in a built-in attached digital camera.   You can then 

download these images to your computer and e-mail them to your 

friends and family, print out the picture using the included software or 

save them in a photo album for future use. Before using the product, 

please read the instructions contained in this manual and take time 

to familiarize yourself with the different parts and features of the 

product.

English
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CAMERA PARTS

1.The camera is powered by two AAA alkaline, lithium, or NiMh batteries (not included). Insert batteries 
into the compartment, with the springs in contact with the negative (flat) end of each battery. A power 
meter on the left center of the display indicates battery condition.

2. Insert an SD card ("upside down" with metal contacts facing up) in the slot if greater storage is desired. 
You may use SD cards (not MMC cards) up to 1 GB capacity. The camera has 8 MB of internal memory 
which can hold over 100 photos, so a card is not necessary. However, the internal memory contents will be 
lost if the batteries are removed or die-unlike photos stored on an SD memory card. A 256 MB standard 
speed SD card is available in most consumer electronics or computer stores and a is good choice for your 
ImageView.

3. Press and hold the MODE button until the camera turns on. The camera will turn off automatically after 
about one minute if no buttons are pressed. Note: when the camera is connected to a computer via the supplied 
USB cable, the camera will power on automatically, and draw power from the computer with no battery drain.

4. Hold the ImageView steady and press SNAP to take a picture (or start/stop shooting a video, when the 
camera is in video mode). The camera focus is preset to take sharp photos from appoximately 35 feet to 
infinity.

5. When using a tripod, you can help avoid the effects of camera shake by plugging the supplied remote 
shutter release into the jack next to the SD card slot, and using the button on the remote rather than SNAP 
to take photos. 

Setup and Basic Operation
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The ImageView will imprint the date and time in the bottom right corner of your photos. To 
set the current date and time, after turning on the camera, press and hold both the MODE and 
SNAP buttons at the same time, until the display begins to flash. The display now shows the 
last two digits of the year. Press the MODE button to move the cursor to the second digit if 
necessary. Press the SNAP button to advance the digit to the current year ("07" for 2007, etc). 
Then press MODE to go to the next number, which is the month. Again, use SNAP to change 
this to the current month. Following the month display is: date, hour (24hr format), minute, 
and second-continue to set these following the same process using the MODE and then SNAP 
buttons. When you have completed all of the date/time settings, the display will stop flashing 
and return to normal.  Note that you will need to reset the date/time after replacing batteries.

Your ImageView is already set to high resolution and quality right out of the box, and it is 
not necessary to use the MODE settings and make any changes to get good results by simply 
pressing the SNAP button to take photos. However, as you might want to shoot a video clip, 
delete one or more previous photos, or explore other options, we recommend you review the 
available mode options listed on the following pages. Briefly pressing the MODE button will 
step through these operational modes in the listed order, and you will see the icon for each 
mode along with its current setting on the display. Use the SNAP button to select the desired 
setting for any mode. If you make no changes, and the SNAP or MODE button is not pressed 
within 5 seconds, the camera will return to normal operation and display. 

Using the Operational Modes/Setting Date & Time
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Mode Icon Settings Description

Video Video 
Camera

OFF, High 
(640x480 pixels 
per frame, 15 fps), 
Low (320x240 
pixels)

Select "Hi" (recommended) or "Lo" video resolution 
instead of "OFF" to put the camera in video mode. 
Wait a few seconds for the camera to automatically 
return to the normal display, then begin shooting by 
pressing SNAP. The counter will show elapsed time-
up to the 53 (Hi) or 132 (Lo) second maximum for 
each video clip. Press SNAP again to stop shooting. 
The counter will advance by one, indicating the 
video file has been saved. Return to the video mode 
setting and select OFF to reset the camera to still 
photo mode. 

Quality Hq or Lq High, Low Select "Hi" (recommended) or "Lo" quality to 
choose the amount of file compression, which affects 
the size of the photo file. "Lo" allows more photos 
to be stored in memory, but at reduced quality.

Resolution Hi or Lo High (640x480 
pixels), Low 
(320x240 pixels)

Select "Hi" (recommended) or "Lo" resolution, 
based on your preference for better looking photos 
(Hi) or being able to take a greater number of 
photos (Lo).

Using the Operational Modes  (Bold indicates default settings)
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Mode Icon Settings Description

Line Frequency 60 or 50 60 Hz, 50 Hz Set to match the AC power frequency (cycles) of 
your country. This ensures that stills and videos shot 
under fluorescent lighting appear normal.

Continuous CT OFF, 3, 5 Select 3 or 5 frames to shoot a rapid series of photos 
instead of a single frame when SNAP is pressed 
(in normal still photo mode). To cancel, enter this 
mode again and select OFF.

Memory Access MEM Sto (USB Mass 
Storage), PC (USB 
Camera)

Select "Sto" to access the internal or card memory 
when the camera is connected to a computer with 
the USB cable. "PC" allows the camera to be 
used as a live USB/PC camera (note that the 8x 
magnification and lack of close focus capability 
limits usefulness in most size rooms)

Delete Last LSt+Trash 
Can

None-press SNAP 
to delete the last 
photo or video

Select this mode and press SNAP to delete only the 
last photo or video you took. The counter will go 
down one number.

Using the Operational Modes
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Mode Icon Settings Description

Delete All ALL+Trash 
Can

None-press SNAP 
to delete all photo 
and video files

Select this mode and press SNAP to erase the entire 
memory contents (the counter resets to zero). 
Use this after downloading your files, to clear the 
memory so you can take new photos. If "Delete All" 
is selected accidently, simply wait a few seconds and 
the camera will return to normal operation.

Format FOr+Trash 
Can

None-press SNAP 
to format card or 
internal memory

If you are using a new SD card, or one previously 
used in other devices, we recommend you select 
Format and press SNAP before you start taking 
photos, to the card is setup with the correct data file 
system for this camera. Note that formatting a card  
erases its contents-please be sure you have backed up 
any previous files first.

Self-Timer Clock OFF or On Photo is taken after a 10 second delay when SNAP 
is pressed (in normal still photo mode.) This can be 
used to avoid accidently shaking the camera when 
the SNAP button is pressed. If the remote shutter 
cable is available, it should be used instead of the 
self timer when the camera is tripod mounted. The 
timer automatically cancels after use.

Using the Operational Modes
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USING THE IMAGEVIEW WITH YOUR COMPUTER:

1. The camera will be recognized as a USB mass storage device (if it is set to "STO" and not "PC"), 
which means no special drivers are required for all operating systems later than Windows 98 (Me, 
2000, XP.) Mac OS 9 and OSX are also compatible. If you have a PC running Windows 98, 
you must install the driver found on the included CD-ROM BEFORE CONNECTING THE 
CAMERA TO YOUR PC. 

2.  If you have a computer OS as listed above that is USB mass storage compliant, a new disc icon will 
appear in Windows Explorer (under “My Computer”) as a new “Removable Disc” after plugging in 
the USB cable from the Imageview. Mac users will see the new disc device appear on their desktop. 
Clicking on the new disc icon will show the contents, a folder named “DCIM.” The image folder 
inside this contains your photos, stored as JPEGs (.jpg file format). They may then be opened, 
edited, renamed and saved using any photo or graphics software that accepts .jpg files. If you do not 
have software that will open .jpg files, you should install MGI Photosuite (Windows only) from the 
included CD-ROM. See “Software Installation” for instructions.

3. After you have copied or opened and saved the photo files to your computers hard drive, you 
may disconnect the Imageview camera (NEVER disconnect the camera while files are still being 
transferred to your computer.) Before disconnecting, you should “eject” or stop the removable disc 
representing the camera to avoid an error message (not necessary with Windows XP). 

4. See the following pages for full step by step instructions to download your photos. 
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System Requirements (Minimum)

Software Installation 

Transferring The Photos & Videos to Your PC - Step by Step

OS: Windows® 98/98SE/2000/ME/XP
CPU: MMX Pentium® 200MHZ equivalent or faster (Pentium® III 500 MHz for PhotoSuite5™)
Memory: 32MB minimum (64MB recommended for PhotoSuite)
SVGA video card w/2MB VRAM, 800x600 screen display, 16 bit High color
200 MB available hard disk space (if installing PhotoSuite)
Internal USB Port

If you are using Windows 98, you must install drivers before connecting the camera to your PC. Insert the CD-ROM 
into your computer’s CD drive; it will auto-run and the install screen will be displayed. Select “Install Driver”, then 
follow the directions. After installation, restart your computer. Windows 2000, ME, and XP do not require drivers, 
as the camera uses the USB mass storage standard , allowing the photo files to be accessed as if they were stored on 
an external hard drive. For any Windows OS, if you are not already using photo editing software you prefer, you may 
install Roxio PhotoSuite® from the CD-ROM. Be sure to read the “Release Notes” completely, noting any tips or 
potential issues relevant to your PC configuration and OS.

1. Be sure the driver has been installed first if you are on Windows 98/98SE.
2. Connect the supplied cable to the ImageView’s USB port, then directly to a main USB port on your computer-do 
not use front panel/keyboard USB ports or unpowered “hubs”.

WARNING: �Make sure you download any picture from your camera before you remove the 
batteries from the camera.
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Transferring The Photos & Videos to Your PC  continued

3. The LCD display will indicate “STO”, and the ImageView will be recognized as a standard “USB 
Mass Storage” device. This means that the camera files can be easily viewed, edited, or copied to your 
hard drive, just as if they were stored on an external hard drive or a CD-ROM.  

4. (This step is not required with Windows XP, simply use the options in the pop-up window to view, copy 
or edit your photos). Open My Computer or Windows Explorer. The camera will be seen as a new 
“Removable Disk” with an unused drive letter assigned to it. Double click this new “Disk” icon, open 
the “DCIM” folder inside, then the folder(s) inside that (“100MEDIA” ,etc). Your photos/videos are 
the files inside-they have the prefix “IMG__” followed by a number, same as seen earlier on the camera’s 
display when you review photos. Single clicking any file should show a small preview image.

5. Click “Edit>Select All” (or click on one photo, contol+click to select multiple photos), then 
“Edit>Copy to Folder” (in Windows menus). Select an existing folder on your hard drive, such as “My 
Pictures”, or create a new folder (“Hawaii Vacation”, etc), then click “OK” to transfer copies of the 
photo files you want.

6. After the photos are transferred to your hard drive, you can disconnect the camera. Windows 2000 
may produce a screen warning that you have disconnected a USB device without stopping or ejecting 
the “disk” first (your photo files will not be harmed). If so, check the box that adds an icon to your 
system tray or taskbar.  Then next time you finish transferring photos, you can click that icon first, and 
“Stop the USB Mass Storage Device” before disconnecting the camera. (On Mac computers, you should 
“eject” the “disk” that appeared on your desktop when the camera was connected.)
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Transferring The Photos & Videos to Your PC continued 
7.  You’re now ready to open the photo files in any photo editing software. Just use File>Open and go to the folder 
where you stored the photos earlier. If you are using PhotoSuite, select File>Open Photo, then use the “Look in” 
pull down menu at the top of the Open window, select “My Computer”, select your hard drive, and double click 
any photo in the folder where you copied the files from the camera. It is also possible to open and work with your 
photos directly from the ImageView while it is still connected.To do this with PhotoSuite, first follow steps 1-3, 
then open PhotoSuite, select File>Open Photo and use the “Look in” menu to select My Computer, then select 
the “Removable Disk”, and open the folders inside until you get to the JPEG photo files. If you choose to work 
this way, from a connected camera, be sure that you save the photo (when you are done editing) to your hard drive, 
and not the camera’s memory or card. To do this in PhotoSuite, after clicking “Done”, answer “Save Changes?” 
with “Yes”, but then answer “Replace Existing File”? with “No” and use the “Save As” dialog box to save the edited 
photo in a folder on your hard drive (“Save In>Local Disk”), not the “Removable Disk” (camera). 

8. If you are new to photo editing on a computer, consult your software’s Help menu (PhotoSuite has extensive 
built-in Help) for tips on using its features. Along with adjusting the brightness, contrast, sharpness and color 
of your photos, you can resize the photo to fit the paper if you are printing, or save a smaller, low or medium 
resolution version for email or inserting into documents. When you are ready to save your edited file, you may 
want to use “Save As” and give it a more descriptive name than “IMG___”. Doing this also preserves the original 
file as a backup to reopen and re-edit later.  Make sure you have successfully transferred all the photos you wanted 
to save before using “Delete All” on your camera to make room for new images.
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 Binocular Instructions
	
Your Bushnell binocular is a precision instrument designed to provide many years of pleasurable 
viewing. This portion of the booklet will help you achieve optimum performance by explaining how 
you can adjust the binocular to your eyes, and how to care for this instrument. Read the instructions 
carefully before using your binocular.

EYE ADJUSTMENTS (Figure 1)
How to Adjust For Distance Between Your Eyes
The distance between the eyes, called “interpupillary distance,” varies from 
person to person. To achieve perfect alignment of lens to eye, follow these 
simple steps.
			 
1. 	 Hold your binocular in the normal viewing position.
2. 	 Grasp each barrel firmly. Move the barrels closer together or further apart 

until you see a single circular field. Always re-set your binocular to this position before using.

How to Adjust For Individual Eye Strength
As individual eyesight varies from one person to another, most Bushnell binoculars have a diopter setting 
feature which allows you to fine-tune the binocular to your vision. Follow the focusing instructions below 
for your type of binocular.

Interpupillary Distance

Fig. 1
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FOCUSING
1.		 Adjust interpupillary distance. (Figure 1)
2.		 Set the “diopter setting” (Figure 2) to zero and view a distant object.
3.		 Keep both eyes open at all times.
4. 	 Using a lens cover or your hand, cover the objective (front) lens of the 

same side of the binocular that has the “diopter setting.” This is usually 
the right side. (The left side on zoom models.)

5. 	 Using the center focus wheel, focus on a distant object with fine detail 
(e.g., brick wall, tree branches, etc.) until it appears as sharp as possible.

6. 	 Uncover the objective lens on the diopter side, cover the other objective lens, then view the same object.
7.		 Using the “diopter setting” adjustment ring, focus the same object being viewed. Caution should 

be used as over turning or forcing the diopter eyepiece can cause damage or cause the eyepiece to 
break away from the chassis.

8.		 Your binocular should be adjusted for your eyes. Focus at any far or near distances can now be 
attained simply by turning the center focus wheel. Make a note of the diopter setting for your eyes 
for future reference.

EYECUPS (Figure 3)
Your Bushnell binocular is fitted with rubber roll-down eyecups designed for 
your comfort and to exclude extraneous light. If you wear sun/eyeglasses, roll 
down the eyecups. This will bring your eyes closer to the binocular lens thus 
providing improved field of view.

diopter setting

Fig. 2

roll-down eyecups

Fig. 3
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INSTRUCTIONS FOR CARE OF BINOCULARS
Your Bushnell binocular will provide years of trouble-free service if it receives the normal care you would 
give any fine optical instrument. The Imageview is not waterproof, and should not be exposed to any 
source of moisture. Water damage is not covered by the warranty.

1.		 If your binocular has roll-down, flexible eyecups, store it with the eyecups up. This avoids excessive 
stress and wear on the eyecups in the down position.

2.		 Avoid banging and dropping.
3.		 Store in a cool, dry place.
4.		 WARNING: Looking directly at the sun with your binocular can cause permanent eye damage.
5.		 Never expose your ImageView binocular to any type of excessive liquid or fluid, as it is not water/

fogproof.
6.		 Take the batteries out of your ImageView if you are not going to use it for a long period of time. (Make 

sure you download any pictures from your camera before you remove the batteries out of the camera.)

CLEANING
1.		 Blow away any dust or debris on the lens (or use a soft lens brush.)
2.		 To remove dirt or finger prints, clean with a soft cotton cloth rubbing in a circular motion. Use of 

a coarse cloth or unnecessary rubbing may scratch the lens surface and eventually cause permanent 
damage. A “microfiber” cleaning cloth (available at most photo dealers) is ideal for the routine 
cleaning of your optics.

3.		 For a more thorough cleaning, photographic lens tissue and photographic-type lens cleaning fluid 
or isopropyl alcohol may be used. Always apply the fluid to the cleaning cloth – never directly on 
the lens.



19

TWO-Year LIMITED WARRANTY
Your Bushnell® product is warranted to be free of defects in materials and workmanship for two years after 
the date of purchase. In the event of a defect under this warranty, we will, at our option, repair or replace 
the product, provided that you return the product postage prepaid. This warranty does not cover damages 
caused by misuse, improper handling, installation, or maintenance provided by someone other than a Bushnell 
Authorized Service Department.
Any return made under this warranty must be accompanied by the items listed below:

	 1)	 A check/money order in the amount of $10.00 to cover the cost of postage and handling
	 2)	 Name and address for product return
	 3)	 An explanation of the defect
	 4)  	 Proof of Date Purchased
	 5) 	 Product should be well packed in a sturdy outside shipping carton, to prevent 
      	 damage in transit, with return postage prepaid to the address listed below:

	 IN U.S.A. Send To: 	IN CANADA Send To:	
	 Bushnell Outdoor Products	 Bushnell Performance Optics
	 Attn.:  Repairs		  Attn.:  Repairs
	 8500 Marshall Drive		 25A East Pearce Street, Unit 1
	 Lenexa, Kansas 66214	 Richmond Hill, Ontario L4B 2M9

For products purchased outside the United States or Canada please contact your local dealer for applicable 
warranty information. In Europe you may also contact Bushnell at:  
					     BUSHNELL Performance Optics Gmbh
					     European Service Centre
					     MORSESTRASSE 4
					     D- 50769 KÖLN
					     GERMANY
					     Tél: +49 (0) 221 709 939 3
					     Fax: +49 (0) 221 709 939 8

This warranty gives you specific legal rights. 
You may have other rights which vary from country to country.

©2006 Bushnell Outdoor Products

FCC Note:
This equipment has been tested and found to comply 
with the limits for a Class B digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful 
interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio 
or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the 
following measures:
·	Reorient or relocate the receiving antenna.
·	Increase the separation between the equipment and receiver.
·	Connect the equipment into an outlet on a circuit  
	 different from that to which the receiver is connected. 
·	Consult the dealer or an experienced radio/TV  
	 technician for help.

The shielded interface cable must be used with the 
equipment in order to comply with the limits for a digital 
device pursuant to Subpart B of Part 15 of FCC Rules.

Specifications and designs are subject to change without 
any notice or obligation on the part of the manufacturer. 
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AVERTISSEMENT
	 AVANT de retirer ou de changer les piles, veillez à télécharger les photos de votre 

appareil, à moins que vous n’ayez utilisé une carte SD plutôt qu’une mémoire 
interne pour stocker vos photos. Si vous n’utilisez pas de carte SD dans l’appareil 
ImageView, nous vous conseillons, avant de le ranger, de télécharger tous les 
fichiers photos en cours pour les conserver, afin d’éviter que les piles ne se 
déchargent durant un stockage prolongé. 

AVERTISSEMENT
NE REGARDEZ PAS directement le soleil à travers vos jumelles.

Cela pourrait causer des lésions oculaires permanentes.

	 REMARQUE: Pour réinitialiser votre appareil photo si vous rencontrez des 
problèmes ou si l’affichage ne réagit pas, retirez les piles pendant au moins une 
minute, puis remettez-les en place. Cela peut causer la perte de toutes les photos / 
vidéos stockées dans la mémoire interne.
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Félicitations pour votre achat de jumelles Bushnell ImageView™ ! Les 

jumelles Bushnell ImageView combinent la technologie de la photo 

numérique avec des jumelles compactes de haute qualité.

Vous pouvez ainsi observer des évènements sportifs, des animaux 

sauvages, des panoramas magnifiques, ou tout ce que vous observez 

normalement avec des jumelles, puis sauvegarder l’image dans un 

appareil photo numérique intégré. Vous pouvez ensuite télécharger 

ces images sur votre ordinateur et les envoyer par courriel à vos amis 

et vos parents, imprimer les images à l’aide du logiciel inclus ou les 

sauvegarder dans un album photo pour usage ultérieur.

Avant d’utiliser le produit, veuillez lire les instructions contenues dans 

ce manuel et prendre le temps de vous familiariser avec les différentes 

parties et fonctions de l’appareil.

Français
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Guide des pièces de l’appareil photo 
et des jumelles

Bouton 
« Snap » 

Bouton 
de modeLentille de 

l’appareil 
photo

Mise au point 
des jumelles

Jack de 
télécommande

Port 
USB

Fente pour 
carte

Compartiment des 
piles

Douille pour 
trépied

(Glissez dans le sens 
de la flèche pour 
ouvrir)
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CAMERA PARTS

1. L’appareil fonctionne à l’aide deux piles alcalines AAA au lithium ou NiMh (non incluses). Insérez les 
piles dans le compartiment, ressorts en contact avec l’extrémité négative (plate) de chaque pile. Un wattmètre 
situé au centre gauche de l’affichage indique l’état de la pile.
2. Insérez une carte SD (« à l’envers », contacts métalliques dirigés vers le haut) dans la fente si vous souhaitez 
une plus grande capacité de stockage.
Vous pouvez utiliser des cartes SD (et non des cartes MMC) d’une capacité maximale de 1 Go. L’appareil 
photo dispose d’une mémoire interne de 8 Mo, capable de contenir plus de 100 photos, de sorte qu’une 
carte n’est pas nécessaire. Toutefois, le contenu de la mémoire interne est perdu si les piles sont retirées ou si 
elles s’épuisent, contrairement au contenu stocké sur une carte mémoire SD.
Des cartes SD standard de 256 Mo sont en vente dans la plupart des magasins d’électronique ou d’ordinateurs 
et sont le choix idéal pour votre ImageView.
3. Appuyez sur le bouton MODE sans le relâcher jusqu’à ce que l’appareil photo s’active. L’appareil se 
désactive automatiquement au bout d’environ une minute si vous n’appuyez sur aucun bouton. Remarque 
: lorsque l’appareil est relié à un ordinateur via le câble USB fourni, il s'active automatiquement et est 
alimenté par l'ordinateur, ce qui évite d’épuiser la pile.
4. Tenez l’ImageView immobile et appuyez sur SNAP pour prendre une photo (ou commencer/arrêter de 
filmer une vidéo, lorsque l'appareil est en mode vidéo).
La mise au point de l’appareil est préréglée de manière à prendre des photos nettes depuis des distances de 
11 mètres (35 pieds) à l’infini.
5. Si vous utilisez un trépied, vous pouvez minimiser les effets des vibrations de l’appareil en branchant le 
déclencheur à télécommande fourni 
dans le jack situé à côté de la fente à carte SD, et en utilisant le bouton de la télécommande plutôt que le 
bouton SNAP pour prendre des photos.

Configuration et principes de fonctionnement
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L’ImageView indique la date et l’heure dans le coin inférieur droit de vos photos. Pour régler la date et 
l’heure en cours, activez l’appareil photo, puis appuyez en même temps sur les boutons MODE et SNAP 
sans les relâcher, jusqu’à ce que l’affichage commence à clignoter. L’affichage indique alors les deux derniers 
chiffres de l’année. Appuyez sur le bouton MODE pour amener le curseur au deuxième chiffre si nécessaire. 
Appuyez sur le bouton SNAP pour avancer le chiffre jusqu’à l’année en cours (« 07 » pour 2007, etc.). 
Appuyez ensuite sur MODE pour passer au nombre suivant, c’est-à-dire le mois. Appuyez à nouveau sur 
SNAP pour afficher le mois en cours. Après le mois viennent : la date, l’heure (échelle de 24 heures), les 
minutes et secondes. Continuez à les régler de la même manière, en utilisant les boutons MODE, puis 
SNAP. Une fois tous les réglages de date et d’heure terminés, l’affichage cesse de clignoter et revient à son 
état normal. À noter : vous devrez procéder à nouveau au réglage de la date et de l’heure après avoir remplacé 
les piles.

Votre ImageView est déjà réglé pour haute résolution et qualité au départ d’usine. Il n’est donc pas nécessaire 
d’utiliser les réglages MODE et de changer quoi que ce soit pour obtenir de bons résultats. Il suffit d’appuyer 
sur le bouton SNAP pour prendre des photos. Toutefois, si vous souhaitez filmer un clip vidéo, effacer une 
ou plusieurs des photos précédentes, ou explorer d'autres options, nous vous conseillons d'étudier les options 
disponibles décrites dans les pages suivantes. Appuyez brièvement sur le bouton MODE pour passer de l’un 
à l’autre de ces modes opératoires dans l’ordre indiqué, et vous verrez s’afficher l’icône avec le réglage actuel 
correspondant à chaque mode. Utilisez le bouton SNAP pour sélectionner le réglage souhaité correspondant 
à chaque mode. Si vous ne faites aucun changement et n’utilisez pas le bouton SNAP ou MODE dans les 5 
secondes, l’appareil photo reprend le  fonctionnement normal et l’affichage normal.

Utilisation des modes opératoires / réglage de la date et de l’heure
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Mode Icône Réglages Description

Vidéo Caméra 
vidéo 

ARRÊT, Haut 
(640x480 pixels 
par image, 15 
fps [images par 
seconde]) Bas 
(320x240 pixels)

Sélectionnez la résolution vidéo “Hi” (recommandée) 
ou “Lo”au lieu de “ARRÊT” pour mettre l’appareil 
en mode vidéo.Attendez quelques secondes que 
l’appareil revienne automatiquementà l’affichage 
normal, puis commencez à filmer en appuyant sur 
SNAP. Le compteur affiche le temps écoulé, jusqu’au 
maximum de 53 secondes (Hi.) ou 132 secondes 
(Lo) pour chaque clip vidéo. Appuyez sur SNAP 
pour arrêter de filmer. Le compteur avance d’un 
cran, indiquant que le fichier vidéo a été sauvegardé. 
Revenez au mode vidéo et sélectionnez OFF pour 
réinitialiser l’appareil pour le mode photo fixe.

Qualité Qualité 	
Hq ou Lq 

Haute, Basse Sélectionnez la qualité “Hi” (recommandée) ou 
“Lo” pour choisir le degré de compression de fichier, 
ce qui affecte la taille du fichier photo. “Lo” permet 
de stocker davantage de photos en mémoire, mais 
cela, au détriment de la qualité.

Résolution Hi ou Lo Haute (640x480 
pixels), Faible 
(320x240 pixels)

Sélectionnez la résolution “Hi” (recommandée) ou 
“Lo” en fonction de vos préférences pour obtenir de 
plus belles photos
(Hi) ou pour pouvoir prendre un plus grand nom-
bre de photos (Lo).

Utilisation des modes opératoires (Gras indique les réglages par défaut)
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Mode Icône Réglages Description

Fréquence 60 ou 50 60 Hz, 50 Hz Réglée pour correspondre à la fréquence CA (cycles) 
de votre pays. Cela garantit que les photos fixes et 
les vidéos prises sous éclairage fluorescent apparais-
sent normales.

Continu CT ARRÊT, 3, 5 Sélectionnez 3 ou 5 images pour prendre une série 
rapide de photos au lieu d’une seule image lorsque 
vous appuyez sur SNAP (en mode photo fixe nor-
mal). Pour annuler, entrez à nouveau dans ce mode 
et sélectionnez OFF (arrêt).

Accès mémoire MEM Sto (mémoire de 
masse USB). PC 
(appareil photo 
USB)

Sélectionnez « Sto » pour accéder à la mémoire 
interne ou la carte mémoire lorsque l’appareil est 
relié à un ordinateuravec le câble USB. « PC » 
permet d’utiliser l’appareil comme appareil photo 
USB/PC actif (il est à noter que le grossissement 8x 
et le manque de capacité limitée de mise au point 
sur une courte distance limite son utilité dans la 
plupart des pièces)

Effacer la 
dernière (photo 
ou vidéo) 

LSt + 
poubelle 

Aucune – appuyez 
sur SNAP pour 
effacer la dernière 
photo ou vidéo.

Sélectionnez ce mode et appuyez sur SNAP pour ef-
facer seulement la dernière photo ou vidéo que vous 
avez prise. Le compteur baisse d’un chiffre.

Utilisation des modes opératoires 
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Mode Icône Réglages Description

Effacer toutes 
(les photos ou 
vidéos) 

ALL + 
poubelle 

Aucune – appuyez 
sur SNAP pour 
effacer tous les 
fichiers photos ou 
vidéos.

Sélectionnez ce mode et appuyez sur SNAP pour ef-
facer tout le contenu de la mémoire (le compteur se 
remet à zéro). Ne faites cela qu’après avoir téléchar-
gé vos fichiers, pour vider la mémoire et pouvoir 
prendre de nouvelles photos. Si « Effacer toutes » 
est sélectionné accidentellement, il suffit d’attendre 
quelques secondes et l’appareil reprendra son fonc-
tionnement normal.

Formatage FOr + 
poubelle

Aucun – appuyez 
sur SNAP pour 
formater la carte 
ou la mémoire 
interne.

Si vous utilisez une nouvelle carte SD ou une carte 
déjà utilisée dans d'autres appareils, nous vous con-
seillons de sélectionner. Formatage et d’appuyer sur 
SNAP avant de commencer à prendre des photos, 
afin que la carte soit configurée avec les fichiers de 
données corrects pour cet appareil. Il est à noter que 
le formatage d’une carte efface son contenu. Assurez-
vous que vous avez sauvegardé les fichiers précédents. 

Retardateur Horloge ARRÊT ou 
marche

La photo est prise avec un retard de 10 secondes lorsque 
vous appuyez sur SNAP (en mode photo fixe normal). 
Cette caractéristique peut servir à éviter toute vibration 
accidentelle de l’appareil lorsque vous appuyez sur le bou-
ton SNAP. Si vous disposez du câble de télécommande 
de déclencheur, utilisez-le au lieu du retardateur lorsque 
l’appareil est monté sur un trépied. Le retardateur s’annule 
automatiquement après usage.

Utilisation des modes opératoires 
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UTILISATION DE L’IMAGEVIEW AVEC VOTRE ORDINATEUR :

1. L’appareil photo est reconnu comme appareil à mémoire de masse USB (s’il est réglé sur « STO » et non sur 
« PC »),ce qui signifie qu'aucun programme d’essai spécial n’est requis pour tous les systèmes d’exploitation 
postérieurs à Windows 98 (Me, 2000, XP). Max OS 9 et OSX sont également compatibles. Si votre ordinateur 
utilise Windows 98, vous devez installer le programme d’essai se trouvant sur le CD-ROM inclus, AVANT DE 
RELIER L’APPAREIL PHOTO À VOTRE ORDINATEUR.

2. Si vous disposez d’un programme d’exploitation (indiqué dans la liste ci-dessus) compatible avec la mémoire de 
masse USB, une fois que vous avez branché le câble USB venant de votre ImageView, une nouvelle icône de 
disque apparaît dans Windows Explorer en tant que « Disque amovible » (sous la rubrique « My Computer »). 
Les utilisateurs d’ordinateurs Mac verront le nouveau disque apparaître sur leur surface de bureau.

Cliquez sur la nouvelle icône de disque pour afficher le contenu, un dossier intitulé « DCIM ». Le dossier d’images 
à l’intérieur contient vos photos, stockées en tant que JPEG (format fichier .jpg). Ces fichiers peuvent être 
ouverts, modifiés, renommés et sauvegardés à l'aide de n'importe logiciel photos ou graphiques acceptant les 
fichiers .jpg. En l’absence d’un logiciel capable d’ouvrir des fichiers .jpg, vous devez installer MGI Photosuite 
(Windows uniquement) se trouvant dans le CD-ROM inclus. Consultez les instructions dans la section « 
Installation de logiciels ».

3. Après avoir copié ou ouvert et sauvegardé les fichiers photos sur le disque dur de votre ordinateur, vous pouvez 
débrancher l’appareil ImageView. (NE débranchez JAMAIS l’appareil durant le transfert de fichiers vers votre 
ordinateur.) Avant de débrancher, vous devez “éjecter » ou stopper le disque amovible représentant l’appareil 
pour éviter tout message d’erreur (ce qui n’est pas nécessaire avec Windows XP).

4. Consultez les instructions étape par étape dans les pages suivantes pour télécharger vos photos.
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Configuration nécessaire (Minimum)

Installation de logiciels

Transfert de photos et de vidéos sur votre ordinateur – Étape par étape

Système d’exploitation : Windows® 98/98SE/2000/ME/XP
Unité centrale : Équivalente ou supérieure à MMX Pentium® 200MHZ (Pentium® III 500 MHz pour 
PhotoSuite5™) 
Mémoire : 32 Mo minimum (64 Mo recommandés pour Photosuite), carte vidéo SVGA avec VRAM 2 Mo, affichage 
écran 800x600, couleur très visible 16 bits 200 MB d’espace disponible sur disque dur (en cas d’installation de 
PhotoSuite), Port USB interne

Si vous utilisez Windows 98, vous devez installer des programmes d’essai avant de relier votre appareil photo à votre ordinateur. In-
sérez le CD-ROM dans le lecteur CD de votre ordinateur ; il s’exécute automatiquement et l’écran d’installation s’affiche. Sélectionnez 
« Install Driver » (installer programme d’essai), et suivez les instructions. Après l’installation, redémarrez votre ordinateur. Windows 
2000, ME, et XP n’exigent pas de programmes d’essai, car l’appareil utilise la mémoire de masse USB, ce qui permet d’accéder aux 
fichiers photos comme s’ils étaient stockés sur un disque dur externe. Pour tout système d’exploitation Windows, si vous ne disposez 
pas déjà d’un logiciel d’édition de photos, vous pouvez installer le Roxio PhotoSuite® qui se trouve sur votre CD-ROM. Veillez à 
lire entièrement les instructions d’utilisation, en notant les astuces ou les problèmes potentiels s’appliquant à la configuration et au 
système d’exploitation de votre ordinateur.

1. Veillez à installer d’abord un programme d’essai si Windows 98/98SE est votre système d’exploitation.
2. Reliez le câble fourni au port USB de l’appareil ImageView, puis directement au port USB principal de votre 
ordinateur. N’utilisez pas les ports USB du panneau avant/clavier, ni des « moyeux » non alimentés.

AVERTISSEMENT : Veillez à télécharger les images de votre appareil avant de 
retirer les piles.
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Transfert de photos et de vidéos sur votre ordinateur  
3. L’écran LCD affiche « STO », et l’appareil ImageView sera reconnu comme un appareil standard « à mémoire de masse 
USB ». Cela signifie que les fichiers de l’appareil photo peuvent être facilement visualisés, modifiés ou copiés sur votre 
disque dur comme s’ils étaient stockés sur un disque dur externe ou un CD-ROM.

4. (Cette étape est facultative avec Windows XP ; utilisez simplement les options de la fenêtre flash pour visualiser, copier 
ou modifier vos photos). Ouvrez « My Computer » (mon ordinateur) ou Windows Explorer. L’appareil photo apparaît 
comme un nouveau « Removable Disk » (disque amovible) avec la lettre de lecteur inutilisé qui lui est affectée. Cliquez 
deux fois sur cette nouvelle icône « Disk », ouvrez le dossier DCIM qui se trouve à l’intérieur, puis le(s) dossier(s) se 
trouvant à l’intérieur de ce dernier (« 100MEDIA », etc.). Vos photos/vidéos sont dans les fichiers à l’intérieur ; elles sont 
dotées du préfixe « IMG_ », suivi d’un numéro, celui que vous avez vu précédemment sur l’écran de l’appareil photo, 
lorsque vous visualisez les photos. Cliquez une fois sur n’importe quel fichier pour faire apparaître une petite image de 
prévisualisation.

5. Cliquez sur « Edit>Select All » (modifier>sélectionner toutes) (ou cliquez sur une photo, control+click pour sélectionner 
plusieurs photos), puis « Edit>Copy to Folder » (modifier>copier vers dossier) (dans les menus Windows).
 Sélectionnez un dossier existant sur votre disque dur, par exemple « My Pictures » (mes photos), ou créez un nouveau 
dossier (« Vacances à Hawaï », etc.), puis cliquez sur « OK » pour transférer les copies des fichiers photos que vous 
voulez.

6. Une fois les photos transférées sur le disque dur, vous pouvez débrancher l’appareil photo. Windows 2000 peut 
produire à l’écran un avertissement indiquant que vous avez débranché un appareil USB sans arrêter ou éjecter le « disque 
» préalablement (vos fichiers photos ne seront pas endommagés). Dans ce cas, vérifiez la boîte qui ajoute une icône dans 
le plateau ou la barre de tâches de votre système. Ainsi, la prochaine fois que vous terminerez le transfert de photos, vous 
pourrez cliquer d’abord sur cette icône et sur « Stop the USB Mass Storage Device » (arrêter l’appareil à mémoire de masse 
USB) avant de débrancher l’appareil. (Sur les ordinateurs Mac, vous devez « éjecter » le disque qui est apparu sur votre 
surface de bureau lors du branchement de l’appareil.)
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Transfert de photos et de vidéos sur votre ordinateur  
7. Vous êtes désormais prêt à ouvrir les fichiers photos dans n’importe quel logiciel d’édition de photos. Il suffit d’utiliser File>Open 
(fichier>ouvrir) et d’aller au dossier où vous avez stocké les photos précédemment. Si vous utilisez PhotoSuite, sélectionnez 
File>Open Photo, puis utilisez le menu déroulant « Look in » (regarder) en haut de la fenêtre Open Window, sélectionnez « My 
Computer », sélectionnez votre disque dur et cliquez deux fois sur n’importe quelle photo dans le dossier où vous avez copié les 
fichiers provenant de votre appareil photo. Il est également possible d’ouvrir et d’utiliser les photos directement depuis l’ImageView 
s’il est encore branché. Pour ce faire avec PhotoSuite, suivez d’abord les étapes 1 à 3, puis ouvrez PhotoSuite, sélectionnez 
File>Open Photo (fichier> ouvrir photo) et utilisez le menu « Look in » (regarder) pour sélectionner « My Computer », puis 
sélectionnez le « Disque amovible » et ouvrez les dossiers se trouvant à l’intérieur jusqu’à ce vous parveniez aux fichiers photos 
JPEG. Si vous choisissez de travailler de cette façon, à partir d’un appareil photo connecté, veillez à sauvegarder la photo (lorsque 
vous avez fini l'édition) sur votre disque dur et non pas dans la mémoire ou la carte mémoire de votre appareil. Pour effectuer 
cette démarche dans PhotoSuite, après avoir cliqué sur « Done » (fini), répondez à « Save Changes? » (voulez-vous sauvegarder les 
changements ?) par Oui, mais ensuite, répondez à « Replace existing File? » (voulez-vous remplacer le fichier existant ?) par Non, 
et utilisez la boîte de dialogue « Save As » (enregistrer sous) pour sauvegarder la photo éditée dans un dossier sur votre disque dur 
(« Save In > Local Disk [Enregistrer dans> disque local] »), et non sur le « disque amovible » (appareil photo).

8. Si vous êtes novice en matière d’édition de photos sur un ordinateur, consultez le menu « Help » (Aide) de votre logiciel 
(PhotoSuite comporte une importante fonction intégrée d’Aide) pour y trouver des détails sur l’utilisation de ses fonctions. 
Non seulement vous pouvez ajuster la brillance, le contraste, la netteté et la couleur de vos photos, mais vous pouvez aussi les 
redimensionner à la mesure du papier si vous l’imprimez, ou sauvegarder une petite version à basse ou moyenne résolution pour 
l’envoyer par courriel ou l’insérer dans des documents. Lorsque vous êtes prêt à enregistrer votre fichier modifié, vous pouvez 
utiliser la fonction « Save as » (enregistrer sous) et lui donner un nom plus descriptif que « IMG_ ». Cela permet de préserver le 
fichier d’origine comme fichier de sauvegarde pour le rouvrir et le modifier à nouveau plus tard. Assurez-vous que vous avez réussi 
le transfert de toutes les photos que vous souhaitiez sauvegarder avant d’utiliser « Delete All » (effacer toutes) sur votre appareil 
photo dans le but de créer de la place pour de nouvelles photos.
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INSTRUCTIONS CONCERNANT L’USAGE DE VOS JUMELLES
	
		  Vos jumelles Bushnell constituent un instrument de précision conçu pour vous assurer de 

nombreuses années d’utilisation. Cette partie du livret vous permettra d’en obtenir une performance 
optimale, car il vous explique comment ajuster vos jumelles en fonction de vos yeux, et comment 
entretenir cet instrument. Lisez bien les instructions avant d’utiliser vos jumelles.

RÉGLAGES EN FONCTION DE VOS YEUX  (Figure 1)
Comment régler la distance entre vos yeux
La distance entre les yeux, appelée « distance interpupillaire », varie d’une 

personne à l’autre. Pour obtenir un alignement parfait entre la lentille et 
l’œil, suivez ces simples étapes.

1. Tenez vos jumelles en position de visée normale.
2. Tenez fermement chaque lunette. Rapprochez ou éloignez les lunettes l’une 

de l’autre jusqu’à ce que vous perceviez un champ circulaire. Remettez 
toujours vos jumelles dans cette position avant de les utiliser.

Comment régler en fonction de votre vision
Comme la vision varie d’une personne à une autre, la plupart des jumelles Bushnell comportent un réglage 

dioptriquequi vous permet de régler avec précision les jumelles en fonction de votre vision. Suivez les 
instructions de mise au point suivantes correspondant à votre type de jumelles.

Interpupillary Distance

Fig. 1

Distance interpupillaire
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MISE AU POINT
1. Réglez la distance interpupillaire. (Figure 1)
2. Mettez le “réglage dioptrique”(Figure 2) sur zéro et observez un objet éloigné.
3. Gardez les deux yeux ouverts en permanence.
4. À l’aide d’un couvercle d’objectif ou de votre main, couvrez l’objectif (l’avant) du 

côté des jumelles qui comporte le « réglage dioptrique », généralement le côté 
droit. (Le côté gauche sur les modèles à zoom.)

5. À l’aide de la molette centrale, effectuez la mise au point pour un objet éloigné 
comportant des détails précis (par ex., un mur en briques, des branches d’arbre, etc.) jusqu’à ce qu’il apparaisse 
aussi net que possible.

6. Découvrez la lentille d’objectif côté dioptre, couvrez l’autre lentille d’objectif, puis observez le même objet.
7. À l’aide de la bague de correction dioptrique, effectuez la mise au point pour l’objet observé. Il convient de 

prendre des précautions, car retourner ou forcer l’oculaire de correction dioptrique peut endommager celui-ci 
ou le détacher du châssis.

8. Vos jumelles doivent être adaptées à vos yeux. La mise au point de loin ou de près peut désormais être réalisée en 
tournant simplement la molette de mise au point centrale. Prenez note du réglage dioptrique en fonction de vos 
yeux pour référence ultérieure.

ŒILLETONS (Figure 3)
Vos lunettes Bushnell sont dotées d’œilletons en caoutchouc rabattables, 
conçus pour votre confort et pour bloquer la lumière parasite.
Si vous portez des lunettes optiques ou des lunettes de soleil, rabattez les 
œilletons. Cela permet de rapprocher vos yeux de la lentille des jumelles, 
améliorant ainsi le champ de vision.

diopter setting

Fig. 2

roll-down eyecups

Fig. 3

réglage dioptrique
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INSTRUCTIONS POUR L’ENTRETIEN DE VOS JUMELLES
Vos jumelles Bushnell vous assureront des années de service sans problèmes si vous en prenez soin 

comme de tout autre instrument d’optique de qualité. L’ImageView n’est pas étanche et ne doit pas 
être exposé à l’humidité. Les dommages causés par l’eau ne sont pas couverts par la garantie.

1. Si vos jumelles sont munies d’œilletons flexibles rabattables, rangez-les avec les œilletons relevés. Cette 
position permet d’éviter les contraintes et l’usure des œilletons s’ils sont en position abaissée.

2. Évitez de heurter et de laisser tomber les jumelles.
3. Rangez-les dans un endroit frais et sec.
4. AVERTISSEMENT : L’observation directe du soleil avec les jumelles peut causer des lésions oculaires 

permanentes.
5. N’exposez jamais vos jumelles ImageView à un excès de liquides ou de fluides, car elles ne sont ni 

étanches ni antibuée.
6. Retirez les piles de votre ImageView si vous prévoyez de ne pas l’utiliser pendant une longue période. 

(Veillez à télécharger les images de votre appareil photo avant de retirer les piles.)
NETTOYAGE
1. Soufflez doucement pour chasser toute poussière ou débris des lentilles (ou utilisez une brosse 

douce).
2. Pour chasser les impuretés ou les traces de doigts, frottez en un mouvement circulaire avec un chiffon 

doux en coton. L’usage d’un chiffon rugueux ou le frottement superflu peut rayer la lentille et causer 
des dommages permanents. Un chiffon de nettoyage en « microfibres » (en vente chez la plupart des 
marchands-photographes) est idéal pour le nettoyage de routine des éléments optiques.

3. Pour un nettoyage plus approfondi, du papier pour lentilles photographiques et du nettoyant 
photographique ou de l'alcool isopropylique peuvent être utilisés.Appliquez toujours le nettoyant 
sur le chiffon – jamais directement sur la lentille.
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Remarque relative à la FCC (Commission fédérale des 
télécommunications)
Ce matériel a été testé et s’est révélé être conforme aux limites 
d’un dispositif numérique de classe B, conformément à la 
section 15 de la réglementation FCC. Ces limites ont été 
établies pour assurer une protection raisonnable contre 
les parasites nuisibles dans les immeubles résidentiels. 
Ce matériel produit, utilise et peut émettre de l’énergie 
radiofréquence ; en conséquence, s’il n’est pas installé et 
utilisé en conformité avec les instructions, il risque de 
provoquer des parasites nuisibles aux communications 
radio. Toutefois, il n’est pas garanti que des parasites ne 
se produiront pas dans une installation particulière. Si ce 
matériel causait des parasites nuisibles à la réception radio 
ou télévision, qui peuvent être déterminés en mettant le 
matériel hors tension puis sous tension, l’utilisateur peut 
essayer de remédier au problème en appliquant l’une ou 
plusieurs des mesures suivantes :
·	Réorienter ou déplacer l’antenne de réception.
·	Augmenter la distance séparant le matériel du récepteur.
·	Connecter le matériel à une prise de courant ou à un 
circuit différent(e) de celui (celle) auquel (à laquelle) le 
récepteur est relié. 
·	Consulter le concessionnaire ou un technicien radio/TV 
expérimenté.

Le câble d’interface blindé doit être utilisé avec le matériel 
afin d’être conforme aux limites d’un dispositif numérique, 
conformément à la sous-section B de la section 15 de la 
réglementation FCC.
Les spécifications et conceptions sont sujettes à 
modification sans préavis ni obligation de la part du 
fabricant. 

GARANTIE LIMITÉE de DEUX ans

Votre produit Bushnell® est garanti exempt de défauts de matériaux et de fabrication 
pendant deux ans après la date d'achat. Au cas où un défaut apparaîtrait sous cette 
garantie, nous nous réservons l'option de réparer ou de remplacer le produit, à condition 
de nous le renvoyer en port payé. La présente garantie ne couvre pas les dommages 
causés par une utilisation, une manipulation, une installation incorrecte(s) ou un 
entretien incorrect ou fourni par quelqu'un d'autre qu'un centre de réparation agréé 
par Bushnell.

Tout retour effectué dans le cadre de la présente garantie doit être accompagné des 
articles indiqués ci-dessous :

	 1)	 un chèque ou mandat d'une somme de 10,00 $ US pour couvrir les frais  
		  d'envoi et de manutention
	 2)	 le nom et l'adresse pour le retour du produit
	 3)	 une description du défaut constaté
	 4)  	 la preuve de la date d'achat
	 5) 	 Le produit doit être emballé soigneusement, dans un carton d'expédition  
		  solide, pour éviter qu'il ne soit endommagé durant le transport ; envoyez-le  
		  en port payé, à l'adresse indiquée ci-dessous :

	 Aux États-Unis, envoyez à:	 Au CANADA, envoyez à:
	 Bushnell Outdoor Products	 Bushnell Performance Optics
	 Attn.:  Repairs		  Attn.:  Repairs
	 8500 Marshall Drive		  25A East Pearce Street, Unit 1
	 Lenexa, Kansas 66214		  Richmond Hill, Ontario L4B 2M9

Pour les produits achetés en dehors des États-Unis et du Canada, veuillez contacter votre 
distributeur local pour tous renseignements concernant la garantie. En Europe, vous 
pouvez aussi contacter Bushnell au :	 BUSHNELL Performance Optics Gmbh
				    European Service Centre
				    MORSESTRASSE 4
				    D- 50769 Cologne
				    Allemagne
				    Tél: +49 (0) 221 709 939 3
				    Fax: +49 (0) 221 709 939 8
	    

La présente garantie vous donne des droits légaux spécifiques. 
Vous pouvez avoir d'autres droits qui varient selon les pays.

©2006 Bushnell Outdoor Products
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ADVERTENCIA
	 Asegúrese de descargar las fotos de la cámara ANTES de quitar o cambiar las 

pilas, a menos que haya estado usando una tarjeta SD en vez de la memoria 
interna para almacenar las fotos. Recomendamos que descargue todos los 
archivos de fotos actuales para guardarlos antes de guardar la ImageView si 
no está usando una tarjeta SD en la cámara, en caso de que las pilas se agoten 
durante un almacenamiento prolongado.

ADVERTENCIA
NO mire directamente al sol por sus binoculares.

Al hacer esto se puede producir daños permanentes en los ojos.

NOTA: Para reajustar la cámara si tiene problemas o si la pantalla no responde, 
saque las pilas al menos un minuto y vuelva a instalarlas. Esto puede resultar en 

la pérdida de todas las fotos/vídeos guardados en la memoria interna.
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¡Enhorabuena por la compra de los binoculares ImageView® de 

Bushnell! Los binoculares ImageView de Bushnell adoptan la 

tecnología fotográfica digital y la combinan con unos binoculares 

compactos de alta calidad. Esto le permite observar acontecimientos 

deportivos, fauna salvaje, vistas pintorescas o cualquier cosa para la que 

normalmente usaría unos binoculares, y después guardar la imagen en 

una cámara digital adjunta integrada. A continuación podrá descargar 

estas imágenes en el ordenador y enviarlas por correo a sus amigos 

y familia, imprimir la foto usando el software incluido o guardarlas 

en un álbum de fotos para el futuro. Antes de usar el producto, lea 

las instrucciones contenidas en este manual y tómese el tiempo para 

familiarizarse con las distintas piezas y características del producto.

Español
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Guía de piezas de cámara y Binocular 

Botón 
Snap 

Botón 
Mode Lente 

de la 
cámara

Enfoque 
de los 
binoculares 

Jack 
remoto

Puerto 
USB

Ranura 
de tarjeta 

Compartimiento 
de las pilas

Adaptador 
de trípode

(abra deslizando 
en el sentido de 
la flecha)
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CAMERA PARTS

1. La cámara está alimentada por dos pilas AAA alcalinas, de litio o NiMh (no incluidas). Introduzca las pilas 
en el compartimiento, con los resortes en contacto con el extremo negativo (plano) de cada pila. La presencia 
de un medidor de corriente en el centro izquierdo de la pantalla indica el estado de las pilas.
 

2. Introduzca una tarjeta SD ("boca abajo" con los contactos de metal apuntando hacia arriba) en la ranura 
si se desea una mayor capacidad de almacenamiento. Puede usar tarjetas SD (no tarjetas MMC) de hasta 
1 GB de capacidad. La cámara tiene 8 MB de memoria interna que puede contener más de 100 fotos, de 
modo que no es necesaria una tarjeta. No obstante, el contenido de la memoria interna se perderá si se sacan 
las pilas o se agotan, a diferencia de las fotos almacenadas en una tarjeta de memoria SD. Se dispone de una 
tarjeta SD estándar de 256 MB en la mayoría de las tiendas de componentes electrónicos o de ordenadores 
y es una buena opción para su ImageView.

3. Pulse sin soltar el botón MODE hasta que se encienda la cámara. La cámara se apagará automáticamente 
después de aproximadamente un minuto si no se pulsa ningún botón. Nota: cuando la cámara esté conectada 
a un ordenador por el cable USB incluido, la cámara se encenderá automáticamente, y absorberá corriente 
del ordenador sin drenar las pilas.

4. Mantenga fija la ImageView y pulse SNAP para tomar una foto (o empezar/dejar de filmar un vídeo, 
cuando la cámara esté en la modalidad de vídeo). El foco de la cámara está prefijado para tomar fotos nítidas 
desde aproximadamente 10,5 m (35 pies) al infinito.

5. Cuando se use un trípode, puede evitar los efectos de vibración de la cámara conectando el disparador del 
obturador remoto suministrado en el jack junto a la ranura de la tarjeta SD, y usando el botón del control 
remoto en vez de pulsar SNAP para tomar fotos.

Configuración y operación básica
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La ImageView imprimirá la fecha y la hora en la esquina inferior derecha de las fotos. Para fijar 
la fecha y la hora actuales, después de encender la cámara, pulse sin soltar los botones MODE y 
SNAP al mismo tiempo, hasta que la pantalla empiece a destellar. La pantalla muestra ahora los 
dos últimos dígitos del año. Pulse el botón MODE para mover el cursor al segundo dígito si es 
necesario. Pulse el botón SNAP para hacer avanzar el dígito al año actual ("07" para 2007, etc). 
Después, pulse MODE para ir al número siguiente, que es el mes. Use nuevamente SNAP para 
cambiar esto al mes actual. A continuación de la pantalla del mes está: fecha, hora (formato 
de 24 horas), minutos y segundos-continúe fijando éstos siguiendo el mismo proceso con los 
botones MODE y después SNAP. Cuando haya completado todos los ajustes de fecha/hora, la 
pantalla dejará de destellar y volverá a normal. Observe que tendrá que reajustar la fecha/hora 
después de reemplazar las pilas. Su ImageView ya está fijada en alta resolución y alta calidad 
nada más sacarla de la caja, y no es necesario usar los ajustes MODE ni hacer ningún cambio 
para obtener buenos resultados pulsando simplemente el botón SNAP para tomar las fotos. 
No obstante, ya que como también podría filmar un clip de vídeo, borrar una o más fotos, 
o explorar otras opciones, recomendamos que revise las opciones de modalidades disponibles 
indicadas en las páginas siguientes. Pulsando brevemente el botón MODE podrá recorrer estas 
modalidades de operación en el orden indicado, y podrá ver el icono para cada modalidad junto 
con su ajuste actual en la pantalla. Use el botón SNAP para seleccionar el ajuste deseado para 
cualquier modalidad. Si no efectúa ningún cambio, y no se pulsa el botón SNAP o MODE en 
un plazo de 5 segundos, la cámara volverá a la operación y visualización normales.

Uso de las modalidades de operación/ajuste de fecha y hora
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Modalidad Icono Ajustes Descripción

Vídeo Cámara de 
vídeo

OFF (apagada), 
High (alta) 
(640x480 pixels 
por cuadro, 15 
pie/s), Low (baja) 
(320x240 pixels)

Seleccione una resolución de vídeo "Hi" 
(recomendada) o "Lo" en vez de "OFF" para 
poner la cámara en la modalidad de vídeo. Espere 
unos pocos segundos para que la cámara vuelva 
automáticamente a la pantalla normal, y después 
empiece a filmar pulsando SNAP. El contador 
mostrará el tiempo transcurrido, hasta 53 (alta) o 
132 (baja) segundos como máximo para cada clip 
de vídeo. Pulse SNAP otra vez para dejar de filmar. 
El contador avanzará una unidad, indicando que el 
archivo de vídeo se ha guardado. Vuelva al ajuste de 
modalidad de vídeo y seleccione OFF para reajustar 
la cámara a la modalidad de fotos fijas.

Calidad Hq o Lq High (alta), Low 
(baja)

Seleccione calidad "Hi" (recomendada) o "Lo" para 
escoger la cantidad de compresión de archivos, lo 
que afecta el tamaño del archivo de fotos. "Lo" per-
mite almacenar más fotos en la memoria, pero de 
menor calidad.

Resolución Hi o Lo High (alta) 
(640x480 
pixels), Low (baja) 
(320x240 pixels)

Seleccione resolución "Hi" (recomendada) o "Lo", 
dependiendo de si prefiere mejores fotos (Hi) o de-
sea almacenar un mayor número de fotos (Lo).

Uso de las modalidades de operación 
(los ajustes predeterminados se indican en negrita)
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Modalidad Icono Ajustes Descripción

Frecuencia de 
línea 

60 ó 50 60 Hz, 50 Hz Fije para hacer coincidir la frecuencia (ciclos) de 
CA de su país. Esto asegura que las fotos fijas y los 
vídeos filmados con iluminación fluorescente parez-
can normales.

Continua CT OFF, 3, 5 Seleccione 3 ó 5 cuadros para tomar una serie rápida 
de fotos en vez de un solo cuadro cuando se pulse 
SNAP (en la modalidad normal de fotos fijas). Para 
cancelar, entre en esta modalidad nuevamente y se-
leccione OFF.

Acceso de 
memoria 

MEM Sto (almace-
namiento masivo 
USB), PC (cámara 
USB)

Seleccione "Sto" para tener acceso a la memoria 
interna o de la tarjeta cuando la cámara esté 
conectada a un ordenador por medio de una cable 
USB. "PC" permite usar una cámara USB/PC en 
vivo (observe que los 8 aumentos y la carencia de 
capacidad de enfoque cercano limita su utilidad en 
la mayoría de los tamaños de habitaciones)

Borrar último LSt+Papelera Ninguno-pulse 
SNAP para borrar 
la última foto o 
vídeo 

Seleccione esta modalidad y pulse SNAP para bor-
rar sólo la última foto o vídeo tomados. El contador 
disminuirá en una unidad.

Uso de las modalidades de operación



43

Modalidad Icono Ajustes Descripción

Borrar todo ALL
+Papelera

Ninguno-pulse 
SNAP para borrar 
todos los archivos 
de fotos y vídeos 

Seleccione esta modalidad y pulse SNAP para bor-
rar todo el contenido de la memoria (el contador se 
reajusta a cero). Use esto después de descargar sus 
archivos para borrar la memoria a fin de poder to-
mar fotos nuevas. Si se selecciona "Delete All" por 
accidente, espere simplemente unos segundos y la 
cámara volverá a la operación normal.

Formato FOr
+Papelera

Ninguno-pulse 
SNAP para for-
matear la tarjeta o 
la memoria interna 

Si está usando una tarjeta SD nueva, o una usada 
con anterioridad en otros dispositivos, recomenda-
mos que seleccione Format y pulse SNAP antes 
de empezar a tomar fotos, de modo que la tarjeta 
esté configurada con el sistema de archivo de datos 
correcto para esta cámara. Observe que al format-
ear una tarjeta se borrará su contenido-asegúrese 
primero de haber hecho una copia de los archivos 
anteriores

Auto-
temporizador

Reloj OFF (desactivado) 
o On (activado)

La foto se toma con una demora de 10 segundos cuando 
se pulsa SNAP (en la modalidad normal de fotos fijas). 
Esto puede usarse para evitar por accidente que se sacuda 
la cámara cuando se pulse el botón SNAP. Si se dispone de 
cable de obturador remoto, éste se debe usar en vez del au-
totemporizador cuando se monte la cámara en el trípode. El 
temporizador se cancela automáticamente después del uso.

Uso de las modalidades de operación
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USO DE LA IMAGEVIEW CON UN ORDENADOR:

1. La cámara será reconocida como un dispositivo de almacenamiento masivo USB (si está fijada en "STO" 
y no en "PC"), lo que significa que no se requieren controladores especiales para todos los sistemas 
operativos posteriores a Windows 98 (Me, 2000, XP). Mac OS 9 y OSX también son compatibles. 
Si tiene una PC con Windows 98, debe instalar el controlador encontrado en el CD-ROM incluido 
ANTES DE CONECTAR LA CÁMARA A SU PC.

2. Si tiene un ordenador OS, según se indica arriba, que cumpla con el almacenamiento masivo USB, 
aparecerá un nuevo icono de disco en Windows Explorer (en “Mi PC”) como nuevo “Disco extraíble” 
después de enchufar el cable USB de la Imageview. Los usuarios de Mac verán aparecer el nuevo 
dispositivo en su despacho. Al hacer clic en el icono del nuevo disco se mostrará el contenido, una 
carpeta llamada “DCIM”. La carpeta de imágenes del interior contiene sus fotos, almacenadas como 
JPEG (formato de archivos .jpg). Pueden abrirse, modificarse, cambiarse de nombre y guardarse usando 
cualquier software de fotos o gráficos que acepte archivos .jpg. Si no dispone de software que abra 
archivos .jpg, debe instalar MGI Photosuite (Windows solamente) del CD-ROM incluido. Vea las 
instrucciones en “Instalación del software”.

3. Después de haber copiado o abierto y guardado los archivos de fotos en el disco duro de su ordenador, 
podrá desconectar la cámara Imageview (no desconecte NUNCA la cámara mientras se estén 
transfiriendo archivos a su ordenador). Antes de desconectar, debe “expulsar” o detener el disco extraíble 
que representa la cámara para evitar un mensaje de error (no es necesario con Windows XP).

4. Vea las páginas siguientes para obtener instrucciones completas paso a paso para descargar las fotos.
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Requisitos del sistema (mínimos)

Instalación del software  

Transferencia de las fotos y vídeos a su PC – Paso a paso

OS: Windows® 98/98SE/2000/ME/XP
CPU: MMX Pentium® 200MHZ equivalente o más rápida (Pentium® III 500 MHz para PhotoSu-
ite5™)
Memoria: 32MB mínimo (64MB recomendada para PhotoSuite)
Tarjeta de vídeo SVGA con 2MB de VRAM, pantalla de 800x600, 16 bit High color
Espacio de disco duro de 200 MB (si va a instalar PhotoSuite)
Puerto USB interno

Si está usando Windows 98, debe instalar los controladores antes de conectar la cámara a su PC. Introduzca el CD-
ROM en la unidad de CD del ordenador; se ejecutará automáticamente y se visualizará la pantalla de instalación. 
Seleccione “Instale el controlador” y siga después las instrucciones. Después de la instalación, vuelva a iniciar su com-
putadora. Windows 2000, ME y XP no requieren controladores, ya que la cámara usa la norma de almacenamiento 
masivo USB, permitiendo tener acceso a los archivos de fotos como si estuvieran almacenados en una unidad de disco 
duro externa. Para cualquier Windows OS, si no está usando ya el software de modificación de fotos preferido, puede 
instalar Roxio PhotoSuite® del CD-ROM. Asegúrese de leer completamente las “Notas de la versión”, observando 
cualquier recomendación o asunto potencial pertenecientes a su configuración PC y OS.

1. Asegúrese de que el controlador se haya instalado primero si está en Windows 98/98SE.
2. Conecte el cable suministrado al puerto USB de ImageView y después directamente al puerto principal de USB 
en su ordenador-no use puertos USB del tablero delantero/teclado o “concentradores” sin corriente.

ADVERTENCIA: Asegúrese descargar cualquier foto de la cámara antes de sacar las pilas de 
la misma.
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Transferencia de las fotos y vídeos a su PC 
3. La pantalla LCD indicará “STO”, y la ImageView será reconocida como un dispositivo estándar de 
“Almacenamiento masivo USB”. Esto significa que los archivos de la cámara pueden verse, modificarse 
o copiarse fácilmente en su disco duro, justo como si se almacenaran en una unidad de disco externa 
o en CD-ROM.
4. (Este paso no se requiere con Windows XP, use simplemente las opciones de la ventana emergente 
para ver, copiar o modificar sus fotos). Abra Mi PC o Windows Explorer. La cámara se verá como un 
nuevo “Disco extraíble” con una letra de unidad sin usar asignada. Haga doble clic en este nuevo icono 
de “Disco”, abra la carpeta “DCIM” de dentro, y después las carpetas de dentro (“100MEDIA”, etc). 
Sus fotos/vídeos son los archivos de dentro-tienen el prefijo “IMG__” seguido de un número, igual que 
se ve antes en la pantalla de la cámara al revisar fotos. Al hacer un solo clic en cualquier archivo se debe 
mostrar una pequeña imagen preliminar.
5. Haga clic en “Editar>Seleccionar todo” (o haga clic en una foto, control+clic para seleccionar múltiples 
fotos) y después en “Editar>Copiar a la carpeta” (en los menús de Windows). Seleccione una carpeta 
existente en su unidad de disco duro, como “Mis imágenes”, o cree una nueva carpeta (“Vacaciones en 
Hawai”, etc), y después haga clic en “OK” para transferir copias de los archivos de fotos deseados.
6. Después de transferir las fotos a su unidad de disco duro, puede desconectar la cámara. Windows 
2000
puede producir una advertencia de pantalla de que se ha desconectado un dispositivo USB sin detenerse 
o expulsar el “disco” primero (sus archivos de fotos no resultarán perjudicados). Si es así, marque la casilla 
que añade un icono a su bandeja del sistema o barra de tareas. Después, la siguiente vez que termine 
de transferir datos, puede hacer clic primero en ese icono, y “Parar el dispositivo de almacenamiento 
masivo USB” antes de desconectar la cámara. (En ordenadores Mac, se debe “expulsar” el “disco” que ha 
aparecido en su despacho cuando se haya desconectado la cámara).
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Transferencia de las fotos y vídeos a su PC 
7. Ahora está listo para abrir los archivos de fotos en cualquier software de modificación de fotos. Use simplemente 
Archivo>Abrir y vaya a la carpeta donde haya guardado las fotos antes. Si está usando PhotoSuite, seleccione 
Archivo>Abrir foto, y después use el menú de despliegue “Buscar en” en la parte de arriba de la ventana Abrir, 
seleccione “Mi PC”, seleccione la unidad de disco duro y haga doble clic en cualquier foto de la carpeta donde se 
copiaron archivos de la cámara. También es posible abrir y trabajar con sus fotos directamente de la ImageView 
mientras siga conectada. Para hacer esto con PhotoSuite, siga primero los pasos 1-3 y después abra PhotoSuite, 
seleccione Archivo>Abrir foto y use el menú “Buscar en” para seleccionar Mi PC. A continuación, seleccione el 
“Disco extraíble” y abra las carpetas de dentro hasta que obtenga los archivos de fotos JPEG. Si desea trabajar de esta 
manera, desde una cámara conectada, asegúrese de guardar la foto (cuando termine la modificación) en su unidad 
de disco duro, y no en la memoria o tarjeta de la cámara. Para hacer esto en PhotoSuite, después de hacer clic en 
“Hecho”, conteste “¿Guardar cambios?” con “Sí”, pero después conteste “¿Reemplazar archivo existente”? con “No” y 
use la casilla de diálogo “Guardar como” para guardar la foto modificada en una carpeta en su unidad de disco duro 
(“Guardar en>Disco local”), no en el “Disco extraíble” (cámara).
8. Si va a modificar una foto por primera vez en un ordenador, consulte el menú de Ayuda del software (PhotoSuite 
tiene una Ayuda integrada amplia) para obtener recomendaciones sobre cómo usar estas características. Junto con el 
ajuste del brillo, contraste, nitidez y color de sus fotos, puede cambiar el tamaño de la foto para que se adapte al papel si 
lo está imprimiendo, o guardar una versión de resolución menor, baja o intermedia para enviar por correo electrónico o 
insertar en documentos. Cuando esté listo para guardar su archivo modificado, puede usar “Guardar como” y darle un 
nombre más descriptivo que “IMG___”. Al hacer esto se conserva el archivo original como una copia de reserva para 
volver a abrir y volver a modificar más adelante. Asegúrese de haber transferido con éxito todas las fotos que deseaba 
guardar antes de usar “Borrar todo” en su cámara para dejar sitio para nuevas imágenes.
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 INSTRUCCIONES PARA LOS BINOCULARES 
	
		  Sus binoculares Bushnell son es un instrumento de precisión diseñado para proporcionar muchos 

años de visión agradable. Esta parte del librito le ayudará a lograr el rendimiento óptimo explicando 
cómo ajustar los binoculares a los ojos, y cómo cuidar este instrumento. Lea las instrucciones con 
cuidado antes de usar los binoculares.

AJUSTES DE LOS OJOS (Figure 1)
Cómo ajustar la distancia entre los ojos 
La distancia entre los ojos, llamada “distancia entre pupilas”, varía de una a 

otra persona. Para lograr el alineamiento perfecto de la lens del ojo, siga 
estos pasos sencillos.

1. Sujete los binoculares en su posición de visión normal.
2. Agarre cada cilindro con firmeza. Acerque o aleje los cilindros hasta que vea 

un solo campo circular. Reajuste siempre los binoculares a esta posición 
antes de usarlos.

Cómo ajustar según la vista de las personas 
Como la vista varía de una persona a otra, la mayoría de los binoculares Bushnell tiene una función de 

ajuste dióptrico que permite ajustar los binoculares con precisión a su vista. Siga las instrucciones 
de enfoque de abajo para su tipo de binoculares.

Interpupillary Distance

Fig. 1

Distancia entre pupilas



49

ENFOQUE
1. Ajuste la distancia entre pupilas. (Figura 1)
2. Fije el “ajuste dióptrico” (Figura 2) en cero y mire a un objeto distante.
3. Mantenga los dos ojos abiertos en todo momento.
4. Usando una tapa de lente o una mano, tape el objetivo (delantero) del 

mismo lado de los binoculares que tienen el “ajuste dióptrico”. Se trata 
normalmente del lado derecho. (El lado izquierdo en los modelos de 
zoom).

5. Usando la rueda de enfoque central, enfoque un objeto distante con un detalle fino (por ejemplo, un 
muro de ladrillo, ramas de árbol, etc.) hasta que aparezca lo más nítido posible.

6. Destape el objetivo en el lado dióptrico, tape el otro objetivo y después mire al mismo objeto.
7. Usando el anillo de “ajuste dióptrico”, enfoque el mismo objeto que se está mirando. Se debe tener 

cuidado, ya que se puede dañar el ocular dióptrico al girarlo excesivamente o forzarlo o se puede 
desprender el ocular del chasis.

8. Sus binoculares deben ajustarse a sus ojos. El enfoque a cualquier distancia lejana o cercana puede 
lograrse ahora simplemente girando la rueda central de enfoque. Haga una nota del ajuste dióptrico 
para sus ojos como futura referencia.

OJERAS (Figura 3)
		  Sus binoculares Bushnell disponen de ojeras de goma que se pueden 

bajar diseñadas para su confort y excluir luz extraña. Si lleva gafas de 
sol/normales, baje las ojeras. Esto acercará sus ojos a las lentes de los 
binoculares mejorando así el campo de visión.

diopter setting

Fig. 2

roll-down eyecups

Fig. 3

ajuste dióptrico
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INSTRUCCIONES PARA EL CUIDADO DE BINOCULARES
		  Sus binoculares Bushnell le proporcionarán muchos años de servicio sin problemas si reciben el 

cuidado normal que le daría a cualquier instrumento óptico de calidad. La Imageview no es a prueba 
de agua, y no debe exponerse a ninguna fuente de humedad. Los daños ocasionados por el agua no 
están cubiertos por la garantía.

1.  Si sus biboculares disponen de ojeras flexibles que se bajan, guárdelos con las ojeras hacia arriba. Esto 
evita una tensión excesiva y el desgaste de las ojeras en la posición bajada.

2.  No la golpee ni la deje caer.
3.  Guarde en un lugar fresco y seco.
4.  ADVERTENCIA: La mirada directa al sol con los binoculares puede causarle daños permanentes 

en elos ojos.
5.  No exponga nunca sus binoculares ImageView a ningún exceso de líquido o fluido, ya que no es a 

prueba de agua/neblina.
6.  Saque las pilas de su ImageView si no va a usarlos durante un período largo. (Asegúrese de descargar 

las fotos de su cámara antes de sacar las pilas).
LIMPIEZA
1.  Sople el polvo o residuos de la lente (o use un cepillo suave para lentes).
2.  Para eliminar la suciedad o las huellas dactilares, limpie con un trapo de algodón suave frotando y 

siguiendo un movimiento circular. El uso de un trapo áspero o el rozamiento innecesario puede 
rayar la superficie de la lente y con el tiempo causar daños permanentes. El uso de un trapo de 
limpieza de “microfibras” (disponible en la mayoría de las tiendas de fotos) es ideal para la limpieza 
de rutina de su sistema óptico.

3.  Para lograr una limpieza más completa, se puede usar papel fotográfico para lentes y fluido de 
limpieza para lentes de tipo fotográfico o alcohol isopropílico. Aplique siempre el fluido en el paño 
de limpieza – nunca directamente en la lente.


